
END-USER LICENSE AGREEMENT 
(EULA) FOR ABBYY SOFTWARE 
IMPORTANT—READ CAREFULLY: This ABBYY End-User Licence Agreement ("EULA") is a legal 
agreement between you (either an individual or a single entity) and ABBYY Software House (ABBYY 
hereinafter), the copyright owner of the software (SOFTWARE hereinafter) supplied together with this 
agreement and may include associated media, printed materials, and "online" or electronic 
documentation. By installing, copying, or otherwise using the SOFTWARE, you agree to be bound by the 
terms of this EULA. If you do not agree to the terms of this EULA, do not install or use the SOFTWARE. 

SOFTWARE LICENCE 
This SOFTWARE is protected by copyright laws and international copyright treaties, as well as other 
intellectual property laws and treaties. This SOFTWARE is licensed, not sold. 

1. GRANT OF LICENCE 
This EULA grants you the following rights: 

1.1 Application Software 
You may install and use one copy of the SOFTWARE on a single computer.  

1.2 Portable Computer 
If you have purchased this SOFTWARE and are the primary user of this SOFTWARE you may copy this 
SOFTWARE onto your portable computer, providing the licence is not shared or used concurrently. 

1.3 Multiple Licence Package 
You may also store or install a copy of the SOFTWARE on a storage device, such as a network server, 
used only to install or run the SOFTWARE on your other computers over an internal network; however, 
you must acquire and dedicate a licence for each separate computer on which the SOFTWARE is 
installed or run from the storage device. A licence for the SOFTWARE may not be shared or used 
concurrently on different computers. 

1.4 Back-Up Copy 
You have the right to make a single copy of the software for back-up purposes in case the original 
SOFTWARE is lost or damaged. The back-up copy may not be used for any other purpose. 
2. COPYRIGHT 
All title and copyrights in and to the SOFTWARE (including but not limited to any images, photographs, 
animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE), the 
accompanying printed materials, and any copies of the SOFTWARE are owned by ABBYY or its 
suppliers. The SOFTWARE is protected by copyright laws and international treaty provisions. Therefore, 
you must treat the SOFTWARE like any other copyrighted material except that you may install the 
SOFTWARE on a single computer provided you keep the original solely for backup or archival purposes. 
You may not copy the printed materials accompanying the SOFTWARE. 

3. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS 

3.1 Reverse Engineering, Decompilation, and Disassembly 
You may not disassemble, reverse engineer, or decompile (get the source code out of the object code) 
the SOFTWARE (applications, databases and other SOFTWARE components), except and only to the 
extent that such activity is expressly permitted by applicable law notwithstanding this limitation. 

3.2 Object Code 
You may not make changes to the object code of applications and databases other than those provided 
for by the SOFTWARE and described in the documentation 

3.3 Separation of Components 
The SOFTWARE is licensed as a single product. Its component parts may not be separated for use on 
more than one computer.



 

3.4 Re-distribution of the SOFTWARE 
Any re-distribution of the SOFTWARE is strictly prohibited. Re-distribution includes granting of access to 
third parties (including network access and other access methods), and also selling, renting, leasing or 
or lending of the SOFTWARE. 

3.5 Transfer of Rights 
You may not transfer the SOFTWARE copyright and other rights related to the SOFTWARE to any other. 

4. SUPPORT SERVICES 
ABBYY may provide you with support services related to the SOFTWARE ("Support Services"). Use of 
Support Services is governed by the ABBYY policies and programs described in the user manual, in 
"online" documentation, and/or in other ABBYY-provided materials. Any supplemental software code 
provided to you as part of the Support Services shall be considered part of the SOFTWARE and subject 
to the terms and conditions of this EULA. With respect to technical information you provide to ABBYY as 
part of the Support Services, ABBYY may use such information for its business purposes, including for 
product support and development. ABBYY will not utilize such technical information in a form that 
personally identifies you. 

5. NOT FOR RESALE SOFTWARE. 
If the SOFTWARE is labelled "Not for Resale" or "NFR," then, notwithstanding other sections of this 
EULA, you may not resell, or otherwise transfer against value, the SOFTWARE. 

6. UPGRADES 
If the SOFTWARE is labelled as an upgrade, you must be properly licensed to use a product identified 
by ABBYY as being eligible for the upgrade in order to use the SOFTWARE. The SOFTWARE labelled 
as an upgrade replaces and/or supplements the product that formed the basis for your eligibility for the 
upgrade. You may use the resulting upgraded product only in accordance with the terms of this EULA. If 
the SOFTWARE is an upgrade of a component of a package of software programs that you licensed as 
a single product, the SOFTWARE may be used and transferred only as part of that single product 
package and may not be separated for use on more than one computer. 

7. DUAL-MEDIA SOFTWARE 
You may receive the SOFTWARE on more than one medium. Regardless of the type or size of medium 
you receive, you may use only one medium that is appropriate for your single computer. You may not 
use or install the other medium on another computer. You may not loan, rent, lease, or otherwise 
transfer the SOFTWARE on the other medium to another user. 

8. TERMINATION 
Without prejudice to any other rights, ABBYY may terminate this EULA if you fail to comply with the 
terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE and all 
of its component parts. 

9. VALID LEGISLATION 
This EULA for SOFTWARE is subject to the country law in which it was purchased. 

10. LIMITED WARRANTY 
ABBYY warrants that (a) the SOFTWARE will perform substantially in accordance with the 
accompanying written materials for a period of ninety (90) days from the date of receipt, and (b) any 
Support Services provided by ABBYY shall be substantially as described in applicable written materials 
provided to you by ABBYY, and ABBYY support engineers will make commercially reasonable efforts to 
solve any problem issues. Some states and jurisdictions do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you. To the extent allowed by applicable law, implied 
warranties on the SOFTWARE, if any, are limited to ninety (90) days. 

11. CUSTOMER REMEDIES 
ABBYY's and its suppliers' entire liability and your exclusive remedy shall be, at ABBYY's option, either 
(a) return of the price paid, if any, or (b) repair or replacement of the SOFTWARE that does not meet 
ABBYY's Limited Warranty and which is returned to ABBYY with a copy of your receipt. This Limited 
Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. Any 
replacement SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) 
days, whichever is longer. Outside the United States, neither these remedies nor any product support 
services offered by ABBYY are available without proof of purchase from an official stockist.



12. NO OTHER WARRANTIES 
To the maximum extent permitted by applicable law, ABBYY and its suppliers disclaim all other 
warranties and conditions, either express or implied, including, but not limited to, implied warranties of 
merchantability, fitness for a particular purpose, title, and non-infringement, with regard to the 
SOFTWARE, and the provision of or failure to provide Support Services. This limited warranty gives you 
specific legal rights. You may have others, which vary from state/jurisdiction to state/jurisdiction. 

13. LIMITATION OF LIABILITY 
To the maximum extent permitted by applicable law, in no event shall ABBYY or its suppliers be liable for 
any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, 
damages for loss of business profits, business interruption, loss of business information, or any other 
pecuniary loss) arising out of the use of or inability to use the SOFTWARE or the provision of or failure to 
provide Support Services, even if ABBYY has been advised of the possibility of such damages. In any 
case, ABBYY's entire liability under any provision of this EULA shall be limited to the greater of the 
amount actually paid by you for the SOFTWARE or US Dollar 5.00; provided, however, if you have 
entered into a ABBYY Support Services Agreement, ABBYY's entire liability regarding Support Services 
shall be governed by the terms of that agreement. Because some states and jurisdictions do not allow 
the exclusion or limitation of liability, the above limitation may not apply to you. 

14. NO WARRANTY 
If you acquired THE SOFTWARE product VIA WEB DOWNLOAD, the following warranty EXCLUSION 
applies to you: 
ABBYY expressly disclaims any warranty for the SOFTWARE.  The SOFTWARE and any related 
documentation is provided "as is" without Warranty or condition of any kind, either expressly or implied, 
including, without limitation, the implied warranties and  conditions of merchantibility, fitness for a 
particular purpose, or non-infringement.  The entire risk arising out of use or performance of the 
SOFTWARE remains entirely with you. 
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Welcome 

Thank you for choosing ABBYY FineReader! 
We all need to input texts into computer. It could be text of 
newspaper and magazine articles, contracts, business letters, faxes, 
price lists, questionnaires, etc. 90% of all the documents we deal 
with are printed on paper. For years on there was only one way to 
input printed documents – you’ve had to type them in from the 
keyboard. Remember the long hours you’ve spent typing text from a 
document? What a great thing it could be if the computer could read 
the text by itself, straight from the sheet of paper! 
Sometimes dreams come true. The FineReader Optical Character 
Recognition (OCR) application will allow your computer and 
scanner  
to do just that – to read printed text by themselves. 
But can’t the scanner do the job on its own? 
No. The scanner only makes a picture, a photograph of the text.  
A photograph is a set of black and white dots, or, in other words, an 
image file, and it can’t be edited in word processors such as MS 
Word, WordPerfect, Word Pro, etc. You need an OCR system that 
will look for symbols in the set of black and white dots, “recognize” 
letters in each symbol and turn the image into computer-editable 
text. Such an application will create a file that text editors and 
desktop systems can cope with. 
So now I can input my document to my computer automatically? 
Yes, now you can input your document to your computer 
automatically without retyping it on the keyboard. 
Enjoy!
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The User's manual 

This user' guide introduces you to the basics of using of ABBYY 
FineReader. Every chapter starts with its short description and the 
chapter contents. 

Online Help 

FineReader's online Help contains basic and advanced information 
on features, settings and dialogs.  

Readme file 

The Readme file contains last-minute information about the 
software. 

Technical Support 

If you have any questions on how to use FineReader, please consult 
all the documentation you have (the User's Guide and the Help File) 
before contacting our technical support service. You may also 
browse the technical support section on our website 
www.abbyy.com. You may find the answer to your question there. 
In case you didn't manage to find the answer, e-mail us at 
support@abbyy.com. Our technical support service experts will 
need the following information to answer your question 
competently: 
• your first and last name  
• your organization name  
• your telephone number (or fax, or e-mail)  
• the serial number of your FineReader distributive  
• build number (see Help/About.../Build)  
• general description of your problem and the full error message 

text (if there was one)  
• you computer and processor type  
• the version of your Windows operating system  
 
You may supply us with any other information you consider 
important. 
You can get some information automatically by clicking the System 
Info button in the About ABBYY FineReader dialog (menu 
Help/About…).
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Chapter  1 

Installing and Starting ABBYY 
FineReader Sprint 

This chapter deals with ABBYY FineReader installation procedures 
and related subjects. 
A special installation program supplied in the distribution package 
carries out the set up of FineReader. Always use the diskette or the 
CD-ROM supplied in the distribution package you got when you 
bought FineReader. Setup and CD-ROM files are saved in such a 
way that the installation program will work incorrectly if you copy 
these files to another diskette or CD-ROM. 

Chapter Contents: 

• Software and hardware requirements  
• Installing ABBYY FineReader Sprint 
• Starting ABBYY FineReader Sprint 

Software and hardware requirements 
You will need the following to run ABBYY 
FineReader 5.0 Sprint: 

• PC with a Intel® Pentium® 133 MHz processor or higher 
• Microsoft® Windows® 2000, Windows® NT® Workstation 

4.0 with Service Pack 3 or greater, Windows® 95, 98 or Me 
• 32 Mb of RAM or higher 
• Microsoft® Internet Explorer 4.0 or higher (Microsoft® 

Internet Explorer 5.01 included in the distribution package) 
• 40 Mb of free hard-disk space for minimal program installation 
• 50 Mb of free hard-disk space for the program operation 
• 100% Twain-compatible scanner, digital camera or fax-modem 
• CD-ROM drive 
• Mouse or other pointing device 
• VGA or other high-resolution monitor
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Installing ABBYY FineReader 5.0 Sprint 
Installation options 

After the setup program has checked the system, type in your name 
and indicate the folder you want to install FineReader 5.0 Sprint in. 
The setup program will then display several installation options: 
• Full – all the components are installed including all recognition 

languages. 
• Minimal (recommended) – the application is installed in its 

minimum configuration: a single interface language selected 
during installation, and two recognition languages – English 
plus one more selected during installation. 

• Custom installation – you may choose any number of 
components included in the distribution package (including 
available recognition languages). 

  

Installing ABBYY FineReader 5.0 Sprint 

If there is only a CD-ROM in the distribution package, do the 
following: 
1. Insert the CD-ROM into the CD-ROM drive.  
2. Click the Start button on the Taskbar and select the 

Settings/Control Panel item. 
3. Double-click the Add/Remove Programs icon. 
4. Select the Install/Uninstall tab and click the Install button.  
5. Follow the installation instructions. 

Note: Steps 2-4 have the same effect as running the Setup.exe setup 
program from the CD-ROM.
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Starting ABBYY FineReader 5.0 Sprint 
To start ABBYY FineReader 5.0 Sprint: 

• Select the ABBYY FineReader 5.0 Sprint item in the 
Start/Programs menu. 

Note: Make sure your scanner is connected to the computer and 
plugged-in and powered-up before you start FineReader Sprint. 
If your scanner has not been connected yet, please consult the user 
guide supplied with the scanner for instructions on scanner 
installation. 

If you don't have a scanner, FineReader Sprint  may recognize your 
image file (see a sample file in the ABBYY FineReader 5.0 
Sprint/Demo folder).
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Chapter  2 

Quick Start 

In this chapter you will learn how to input a document without even 
knowing anything about how ABBYY FineReader works!  
You will also learn what windows and toolbars are there in 
FineReader.  
If you're already experienced with FineReader you may skip all text 
up to “Features of ABBYY FineReader 5.0 Sprint” section. 

Chapter Contents 

• How to input a document using a scanner 
• How to read an image file 
• ABBYY FineReader Sprint toolbar 

How to input a document using a scanner 
1.  Turn on the scanner in case it has a separate power source from 

your PC. 
2. Turn on the computer and start FineReader Sprint  

(Start/Programs/ABBYY FineReader 5.0 Sprint). You will 
see the FineReader Sprint  main window. 

3. Put the page you want to read into the scanner. 
4. Click  the Scan&Read button. Document input process is 

made up of three steps: scanning, reading and saving the 
recognized text. 
In the Image window you will see a "photograph" of the page. 
After that the program will start recognizing the image and in 
30-90 seconds you will see the result in the Text window. 

5.  Now you can send the results to another application or save it 
to a file.
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How to read an image file 
1. Turn the computer on. 
2. Run ABBYY FineReader Sprint . To do this, from the Start 

menu, select Programs/ABBYY FineReader 5.0 Sprint. 
3. Click the arrow right to the Scan&Read button.  Select the 

Open&Read item in the local menu.  
4. Select the necessary image file in the Open dialog box. This 

can be a file with a TIF, PCX, BMP, DCX or JPEG extension 
(the complete list of supported graphic formats is given in 
“Supported image formats”).  
For example, open a sample image (you can find a sample 
image file in the Demo folder). 

5. This folder is located in the folder you have installed 
FineReader Sprint  in. In the Image window you will see a 
"photograph" of the page. After that the program will start 
recognizing the image and in 30-90 seconds you will see the 
result in the Text window. 

6. Now you can send the results to another application or save it 
to a file. 

ABBYY FineReader Sprint Toolbar 
The toolbar buttons are definitely the most convenient way to access 
the application functions; however, the same functions may be 
accessed via menus or hot keys. If you want to find out what a 
particular toolbar button is for, just move the mouse pointer to it. 
The button's tooltip will be displayed, and the status bar will display 
some more button details. 
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The toolbar buttons launch the main FineReader Sprint  functions: 
Scanning, Reading and Saving the recognition results. The 
numbers on the buttons indicate the order in which the respective 
document input actions should be performed. You may perform 
each action separately or you may combine them into one by 
clicking the Scan&Read button.  
Each button features several function modes. Click the arrow right 
to the button and select the mode you like in the local menu. The 
button icon always displays the last selected mode. Click the button 
itself to run this mode again.  
 

 

 
 

 
Scan&Read – starts scanning and reading a 
document using the current options. 
Scan&Read Multiple Images- scans and reads 
several images in a row. 
Open&Read – opens and reads the images selected in 
the Open dialog. 

 

 
 

 
Open Image-opens an image. 
Scan Image – scans an image. 
Select the Stop Scanning item in the File menu to 
stop the scanning.  

 

 
 

 
Read – reads an open page. 

 

 
 

 
Save Text to File- saves the recognized text to a disk 
file. 
Send to... – exports recognized page into the 
application you select without saving the text on disk 



ABBYY FineReader Sprint 5.0 User’s Guide 

9 

Chapter  3 

General Features of ABBYY 
FineReader Sprint 

FineReader provides you with tools for document input into the 
computer. All you have to do is click the Scan&Read button once – 
all the rest is done by the application, so you don't have to spend 
any time studying its intricacies. You can send the recognized text 
to a word processor or a spreadsheet application, you can save it in 
RTF and TXT, thus retaining the full document layout. 

Chapter Contents 

• Features of ABBYY FineReader 5.0 Sprint 
• Supported document saving formats  
• Supported image formats  
• Supported recognition languages  

Features of ABBYY FineReader 5.0 Sprint 
An OCR (Optical Character Recognition) system enables you to 
input printed documents into your computer automatically via a 
scanner without retyping. 
FineReader is an omnifont optical text recognition system. It means 
that the system recognizes texts set in practically any font without 
prior training. One of FineReader’s characteristic features is its high 
recognition accuracy and low sensitivity to print defects. These 
features are due to a special recognition technology based on the 
principles of Integral Purposeful Adaptive (IPA) perception, which 
is fully implemented in FineReader. 
All you have to do is click the Scan&Read button and FineReader 
will do the rest. 
As a result, you won’t have to spend time learning the program.   

 
• Support of 100 % TWAIN-compatible scanners. 
• Simple and user-friendly interface. 
• "One-Button" scanning and recognition (Scan&Read). 
• Drawing and editing blocks manually. 
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• Automatic table layout analysis. 
• Viewing of recognition results. 
• Uncertainly recognized characters are highlighted with color. 
• Save in RTF and TXT formats with full page layout retention. 
• Exporting recognition results into Microsoft Word 6.0, 7.0, 97 

(8.0), 2000 (9.0), 2002 (10.0); Microsoft Excel 6.0, 7.0, 97 
(8.0), 2000 (9.0), 2002 (10.0); Corel WordPerfect 7.0, 8.0, 9.0, 
2002 (10.0); Lotus Word Pro 9.5, 97, Millennium Edition. 

• Working with color images. 

Supported document saving formats 
ABBYY FineReader Sprint saves the 
recognition results in the following formats: 

• Rich Text Format (*.RTF)  
• Plain Text (*.TXT). 

 Supported image formats 
ABBYY FineReader Sprint opens image files in 
the following formats: 

BMP: 2-bit – black and white 
4- and 8-bit – Palette  
16-bit – color mask 
24-bit – Palette and TrueColor 
32-bit – TrueColor 

PCX, 
DCX:  

2-bit – black and white 
4- and 8-bit – gray 

JPEG: gray and TrueColor 

TIFF: black and white – uncompressed, CCITT3, 
CCITT3FAX, CCITT4, Packbits 
gray – uncompressed, Packbits, JPEG 
TrueColor – uncompressed, JPEG 
Palette – uncompressed, Packbits 
multi image TIFF 

PNG: black and white, gray, color 
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ABBYY FineReader Sprint saves image files in 
the following formats: 

BMP: black and white, gray, color 

PCX: black and white, gray 

JPEG: gray, color  

TIFF: black and white – uncompressed, CCITT3, 
CCITT3FAX, CCITT4, Packbits 
gray – uncompressed, Packbits, JPEG 
color – uncompressed and JPEG 

PNG: black and white, gray, color 

Supported languages 
ABBYY FineReader 5.0 Sprint supports 176 recognition languages: 

 
Main 
languages 
(with 
dictionary 
support) 

Armenian (Eastern, Western, 
Grabar), Bulgarian, Croatian, 
Czech, Danish, Dutch (Netherlands 
and Belgium), English, Estonian, 
Finnish, French, Catalan, German 
(new and old spelling), Greek, 
Hungarian, Italian, Latvian, 
Lithuanian, Norwegian (nynorsk 
and bokmal), Polish, Portuguese 
(Portugal and Brazil), Romanian, 
Russian, Slovak, Spanish, 
Swedish, Tatar, Turkish, 
Ukrainian 
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Additional 
languages 

Abkhaz, Adyghian, Afrikaans, 
Agul, Albanian, Altai, Avar, 
Aymara, Azerbaijani (cyrillic), 
Azerbaijani (latin), Bashkir, 
Basque, Belarusian, Bemba, 
Blackfoot, Breton, Bugotu, Buryat, 
Cebuano, Chamorro, Chechen, 
Chukchee, Chuvash, Corsican, 
Crimean Tatar, Crow, Dakota, 
Dargwa, Dungan, Eskimo 
(cyrillic), Eskimo (latin), Even, 
Evenki, Faroese, Fijian, Frisian, 
Friulian, Gagauz, Galician, Ganda, 
German (Luxemburg), Guarani, 
Hani, Hausa, Hawaiian, Icelandic, 
Indonesian, Ingush, Irish, Jingpo, 
Kabardian, Kalmyk, Karachay-
balkar, Karakalpak, Kasub, 
Kawa, Kazakh, Khakass, Khanty, 
Kikuyu, Kirghiz, Kongo, Koryak, 
Kpelle, Kumyk, Kurdish, Lak, 
Latin, Lezgi, Luba, Macedonian, 
Malagasy, Malay, Malinke, 
Maltese, Mansy, Maori, Mari, 
Maya, Miao, Minangkabau, 
Mohawk, Moldavian, Mongol, 
Mordvin, Nahuatl, Nenets, Nivkh, 
Nogay, Nyanja, Ojibway, 
Ossetian, Papiamento, Provencal, 
Quechua, Rhaeto-romanic, 
Romany, Rundi, Russian (old 
spelling), Rwanda, Sami (Lappish), 
Samoan, Scottish Gaelic, Selkup, 
Serbian (cyrillic), Shona, 
Slovenian, Somali, Sorbian, Sotho, 
Sunda, Swahili, Swazi, Tabasaran, 
Tajik, Tagalog, Tahitian, Tok 
Pisin, Tongan, Tswana, Tun, 
Turkmen, Tuvinian, Udmurt, 
Uzbek (cyrillic), Uzbek (latin), 
Welsh, Wolof, Xhosa, Yakut, 
Zapotec, Zulu 
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Artificial 
languages 

Esperanto, Interlingua, Ido, 
Occidental,  

Formal 
languages 

Basic, C/C++, COBOL, Fortran, 
JAVA, Pascal, Simple chemical 
formulas 
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Chapter  4 

Acquiring the Image 

Recognition quality depends greatly on the quality of the source 
image.  
In this chapter you will learn how to scan the document properly,  
how to open and read an image you already have on your PC (see 
the list  
of supported image formats in “Supported Image Formats” section),  
how to process images and make them good for recognition etc.  

Chapter Contents 

• Scanning 
• Setting scanning parameters 
• Tips on brightness tuning 
• Opening image 
• Opening image using Clibpoard or drag-&-drop 
• Working with imageScanning 
FineReader Sprint  "talks" with scanners via the TWAIN interface. 
It is a universal standard adopted in 1992 in order to unify the 
interaction of devices providing image input into computer (such as 
scanners) and external applications. 
Important: Consult the documentation supplied with the scanner to 
connect it correctly. After you've connected the scanner to the 
computer, do not forget to install a TWAIN-driver and/or a scanning 
application. 

To set the scanner you will work with : 

Choose the Select scanner item in the File menu. 

To start scanning: 

 

Click the 1-Scan button or select the Scan item in the File menu. 
The Image window displaying a "photograph" of the scanned page 
will appear in the FineReader Sprint  main window.  
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If scanning doesn't start right away, a dialog will open:  
The scanner's TWAIN-Source dialog. Check the scanning options 
and click the ОК button to start scanning. 
Tip: 
To start the recognition process immediately after scanning, use the 
Scan&Read option: 
 

 

Click the Scan&Read button . 

 
FineReader Sprint will scan and read the images. The Image 
window displaying a "photograph" of the scanned page and the 
Text window displaying the recognition results will appear in the 
FineReader Sprint main window. The recognized text may be sent 
to various external applications- and saved in various formats. 

Setting scanning parameters 
Recognition quality depends greatly on the scanned image 
quality. The image quality may be adjusted by setting the main 
scanning parameters: resolution, scan mode and brightness.   

The main scanning parameters are: 

Resolution – use 300 dpi resolution for regular texts (font size 10pt. 
or greater) and 400-600 dpi resolution for texts set in smaller font 
sizes (9pt. or less). 
Scan mode – gray.  
Scanning in grayscale mode will yield  the best recognition 
results. If you scan your images in grayscale, the application tunes 
the brightness automatically. 
Scan mode – black and white. 
The black and white scan mode enables the system to scan at a 
higher speed, but at the same time some character information is 
lost. This may have a negative effect on the recognition quality of 
the documents of medium and low print quality. 
Scan mode – color. 
Select the color scan mode for scanning and retaining color 
docments.   It scans and recognizes color documents with pictures, 
color text and background, and retains the color in  electronic 
documents. 
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Brightness – in most cases the medium brightness value (50%) 
will do. 
Some documents scanned in black and white mode may require 
some additional brightness tuning. 

Note: Scanning at 400-600 dpi resolution (instead of the default 300 
dpi) or scanning in gray or color (instead of black& white) mode 
takes more time. For certain scanners, it may take up to four times 
longer to scan a document in 600 dpi than scanning in 300 dpi. 

To set scanning parameters: 
If you want to scan your images using the TWAIN-Source interface, 
your scanner's TWAIN dialog opens automatically when you click 
the 1-Scan button. Set the scanning parameters in the dialog. 
Scanning options may have different names depending on the 
scanner model; for example, the word "threshold" may be used for 
brightness, or the brightness control may be displayed as a "sun" or 
a black and white circle. The exact options are described in the 
documents supplied with your scanner. 

Tips on brightness tuning 
The scanned image has to be legible. 
 

 
 – an example of a good image (from the OCR point of view) 

If you see that the scanned image is far from perfect (characters are 
glued or torn), consult the table below to find how you can improve 
the image quality. 
 

Your image looks like this: Possible remedy: 

 
characters are "torn" or very 
light  

Try to decrease the brightness (it will make the image darker). 
Try to scan it in gray mode (the brightness autotuning is used in 
this case). 

 
characters are distorted, 
glued, or filled  

Try to increase the brightness (it will make the image brighter). 
Try to scan it in gray mode (the brightness autotuning is used in 
this case). 
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Opening Images 
If you don't have a scanner, you may still recognize image files (see 
the list of supported image formats in the “Supported Image 
Formats section”).  

To open an image: 

• Click the arrow right to the 1-Scan button and select the Open 
Image item in the local menu. The 1-Scan button icon will 
change – the Scan caption will be replaced with the Open 
caption. 

• Select the Open image item in the File menu. 
• Select the image in the Open dialog.It will be displayed in the 

Image window of FineReader Sprint.  
Tip: To open and recognize the image automatically, use the 
Open&Read mode: 
1. Select the Open&Read item in the Process menu or just press 

CTRL+SHIFT+D. The Open dialog will open. 
2. Select the image for recognition in the Open dialog. 

Opening image using Clipboard or drag-&-
drop 

Clipboard 

ABBYY FineReader Sprint can open file or bitmap images from 
clipboard. To do it, select the Paste image item in the Edit menu.  

Drag-&-drop 

You can use drag-&-drop to open image files in FineReader Sprint.  
1. Make sure ABBYY FineReader Sprint is running. 
2. Select the  image file. 
3. Click and drag the selection on the Taskbar. 
4. Wait till ABBYY FineReader Sprint becomes active. 
5. Move the mouse pointer over the FineReader’s window and 

release the mouse button.
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Working with Image 
Invert image 

Some scanners invert images (turning black color into white and 
vice versa) during scanning.  
You may want to apply the Invert Image option to make the 
document appearance standard, i.e. black font against a white 
background. To do it:  
• Select the Invert Image item in the Image menu. 

Rotate image 

The recognition quality depends on the image having the standard 
orientation (the text should be read top-down and the lines should be 
horizontal). By default FineReader Sprint detects the page 
orientation automatically during recognition. If FineReader Sprint 
detected the page orientation incorrectly:  
• Select the Rotate Clockwise item in the Image menu to rotate 

the image 90° clockwise.  
• Select the Rotate Counter-Clockwise item in the Image menu 

to rotate the image 90° counter-clockwise. 
• Select the Rotate Upside Down item in the Image menu to 

rotate the image 180°. 

Increase/Decrease the image scale  

• Select the you need in the Veiw menu, or 
• Right-click the image and select the scale you need in the local 

menu.
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Chapter  5 

Page Layout Analysis 

FineReader Sprint must "know" what image areas it needs to 
recognize before it starts recognition. It's the page layout analysis 
procedure that serves this purpose. This procedure draws text 
blocks, picture blocks and tables.  
In this chapter you will learn more about the following: when 
manual page analysis may be needed, what block types there are, 
how blocks drawn by automatic layout analysis procedure could be 
edited. 

Chapter Contents 

• General information on page layout analysis 
• Block types 
• Drawing and editing blocks manually 

General information on page layout 
analysis 

In most cases, FineReader Sprint is capable of analyzing complex 
page layouts. Start the automatic analysis by clicking the 2-Read 
button. The recognition will be performed simultaneously with the 
layout analysis.  

 

Note: A standalone procedure of page layout analysis is also 
available (menu Process>Analyze Layout). You may run this 
standalone procedure if needed, but remember that in this case the 
page layout analysis quality could be inferior, because the coupled 
layout analysis/recognition procedure run by the above-mentioned 
button uses additional information acquired during the recognition 
to aid layout analysis.  

You may want to draw blocks manually if:  

• You want to recognize only a part of a page; 
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Note: Some manual table layout analysis features are not available 
in ABBYY FineReader Sprint: you can’t add or remove separators; 
merge or split table cells. 

Block types 
Blocks are image areas enclosed in frames. Blocks tell the system 
what image areas to recognize and in what order. The blocks also 
affect how the original page layout is retained.  Different types of 
blocks are represented in different colors. 

The following block types are available: 

Recognition Area – this block type is used for automatic 
recognition and analysis. After you click the 2-Read button, all 
blocks of this type will be automatically analyzed and recognized.  
Text – The Text Block marks the text image areas. It should only 
contain text formatted in one column. If there are pictures inside the 
text, draw separate blocks for them. 
Table – The Table Block marks the table image areas including 
tables with or without grid lines. This block is represented as a table 
in the output text. 
Picture – Picture blocks are used to mark image areas containing 
pictures. A block of this type may enclose an actual picture or any 
other object (say, a section of text) you want to be displayed as a 
picture in the recognized text. 

Drawing and editing blocks manually 
To create a new block: 

1. Position the mouse at the point where you want a corner of 
your block to be.Hold down the left mouse button and drag the 
mouse pointer to the point where you want the opposite block 
corner to be. 

2. Release the mouse button.  
A frame will enclose the image area you selected. By default, it is 
recognition area.
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To change the block type: 

You may then change the block type. The drawn block type may be 
one of the following: Recognition Area, Text, Table, or Picture 
(see “Block Types”). To change the block type: 
• Right-click the block and select the Block Type item and then 

the corresponding block type in the local menu. 

To move the block borders: 

1. Click the block border and hold down the left mouse button. 
The mouse pointer will become a two-headed arrow. 

2. Drag the pointer in the direction you need.  
3. Release the mouse button. 

Note: If you click a block corner, you will drag both horizontal and 
vertical borders of the block at the same time. 

Make the block active 

• Click the block. 
Rectangles appear on the corners of the block and its frame becomes 
thicker. 

Activate several blocks: 

• Holding down the CTRL key, click the necessary blocks. 

Delete one or several blocks 

• Select the necessary blocks with the mouse (to select several 
blocks at once hold down the CTRL key) and press DEL. 

Delete all blocks  

• Right-click the image and select Delete All Blocks and Text 
(CTRL+DEL) from the local menu. 

Note: If the image you delete blocks on has already been 
recognized, all the recognized text in the Text window will also be 
deleted.
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Chapter  6 

Recognition 

The aim of the OCR is to read text from the source image and to 
retain the source page layout as well. 

Chapter Contents 

• General information on recognition 
• Recognition language 

General information on recognition 

Note: Check the recognition language before you start recognition 
(selected language is displayed on the Statusbar). 

To start recognition: 

 

• Either click the 2-Read button on the toolbar, or 
• Select the Read item in the Process menu. 
 

 

Note: When you perform OCR on a block that had already been 
recognized, recognition will only be applied the modified and added 
blocks.
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Recognition language 
• To set the text recognition language, select the appropriative 

item in the Language menu. 
 

If you  can’t find the recognition language you need in the language 
list, please check the following:  
1. The language is not supported by FineReader Sprint. See the 

full list of recognition languages in the Supported Languagest 
languages section. 

2. The language may not been installed (the minimal installation 
mode was used) or the language had been disconnected during 
the custom installation. To install additional languages run the 
FineReader Sprint installation program in the component 
installation mode (Custom installation).  

Select the languages you need. 
 

Note: Make sure you've indicated the same folder you've installed 
ABBYY FineReader Sprint in.
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Chapter  7 

Saving into External 
Applications and Formats 

 
The recognition results can be saved to a file, sent to an external 
application without saving or copied to the clipboard.  
FineReader Sprint exports the recognition results into the following 
applications:  Microsoft Word 6.0, 7.0, 97 (8.0), 2000 (9.0), 2002 
(10.0); Microsoft Excel 6.0, 7.0, 97 (8.0), 2000 (9.0), 2002 (10.0); 
Corel WordPerfect 7.0, 8.0, 9.0, 2002 (10.0); Lotus Word Pro 9.5, 
97, Millennium Edition. 

Chapter Contents 

• Saving the recognized text 
• Saving the recognized text using drag-&drop 
• Saving the recognized text using Clipboard 
• Saving the page image 

Saving the recognized text 
You may: 

• save the recognized text using the 3-Save button, 
• send the recognized text to another application using drag-&-

drop, 
• send the recognized text using the Clipboard. 
 

 

Click the 3-Save button to send the recognition results to the 
application you need or save them to a file. The icon appearance 
depends on the saving mode currently on. The Save button caption 
displays the name of the currently selected export application. 

To save the recognized text: 

• Click the arrow right to the 3-Save button and select the item 
you need in the local menu.  
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After the exporting is completed, FineReader will launch the target 
application automatically with the recognized text placed in the 
window. The 3-Save button icon automatically “remembers” the 
last operation – sending the recognized text to an application or 
saving it to a file. Because the 3-Save button icon adopts the icon of 
the last export method used, you can export another image using the 
same method by clicking the icon again without having to browse 
the button's local menu.  

Saving recognized text using drag-&-drop 
1. Make sure destination application is running. 
2. Select the necessary text selection in ABBYY FineReader 

Sprint’s viewer. 
3. Click and drag the selection on the Taskbar. 
4. Wait until the application’s window becomes active. 
5. Position a mouse pointer where necessary and release the 

mouse button. 
The selection will be pasted to the destination application. 

Saving the recognized text using Clipboard 
1. Select the necessary text selection in ABBYY FineReader 

Sprint’s Text viewer. 
2. Select the Copy item in the Edit or local menu. The selected 

text is copied to the Clipboard. 
3. Open the necessary file in the appropriative application. 

Position the mouse pointer where you want to paste the 
selection and do the Paste operation. 


